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Office 2007 Preview Video

Welcome to the new 2007 Office system!

H For a preview into the new 2007 Office system, click on the video link to the left.
' Feel free to take notes anywhere on this page while you're watching the video.
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How to Navigate this Course

Click the colored tabs on the top of the page to move to another section of the course.

Introduction . Fluent UI\Word \ Excel \Powerpoint\ﬁuﬂook\lnfopa.th\Access Publisher . OneMote Groove\ﬂommunicat..:\[\-"lore Training

Click the tabs on the right side of the page to get to the details of each section.

Going to a Specific Topic
On page two of the Introduction tab isTable of Content<Click the topiclink in the TOC to go to that specific page.

Note: Like in Internet Explorer, use the Back button to return to the page you were on previously.
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Searching this Notebook

As you spend more time within the new Office, you may find that you want to reference items in this notebook. Usingdhésear the upper right hand
corner of your screen, you can easily search this notebook or your entire set of notebooks.

Search This Notebook & ¥

Flagging Action Items

As you go through this course, you may want to create action items to complete. To help you follow up on these, yotec@utimak tasks that will link to
your notes. Atany pointin the notebook where you see an item that you want to flag, use the Task menu on the Starlurtbtordate an Outlook task.

2 B9
OQutlook Tasks:

¥ Today Ctrl+Shift+1
¥ Tomorrow Ctrl+Shift+2
N This Week Ctrl+Shift+3
N Mext Week Ctrl+Shift+4
Y NoDate Ctrl+Shift+5
¥ Custom.. Crl+Shift+ K
Pt

More Information
How Do | Use OneNote?

View theOneNote Basics
Check out th®©neNotesection
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onenote:OneNote.one#section-id={249EC36F-A43A-4612-8027-B5F1CE7E1FB4}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
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I've watched the introductory video, now what?

Start off your training herewith the new Fluent User Interface:
3 The New User Interface

Then proceed to the other sections, focusing on the different programs within the 2007 Office sy:
Word

Excel
PowerPoint
Outlook
InfoPath
Access
Publisher
OneNote
Groove
Communicator
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There is also additional training information here:
3 More Training
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onenote:Word.one#section-id={C4237D65-090D-4232-A02B-1C3986271DA1}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
onenote:Excel.one#section-id={BA295623-E677-42C4-A4C9-C2C4AB9A708C}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
onenote:PowerPoint.one#section-id={D998C155-85AB-4700-841D-898ECE92F83C}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
onenote:Outlook.one#section-id={5F3C8ED5-A49F-4521-825F-7AADAF87302F}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
onenote:InfoPath.one#section-id={7202AEF0-C40E-4232-95DC-FC0E9B65253B}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
onenote:Access.one#section-id={13100793-31A4-4114-A0C2-99733303C3A2}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
onenote:Publisher.one#section-id={6D048B8A-83AA-4B43-AB9E-C286F42095BC}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
onenote:OneNote.one#section-id={249EC36F-A43A-4612-8027-B5F1CE7E1FB4}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
onenote:Groove.one#section-id={AB8736B9-72BA-461F-BE54-14ED8D86AC38}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
onenote:Communicator.one#section-id={F4F9708D-E4BC-482C-9AF7-8DFD9932D84D}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
onenote:More%20Training.one#section-id={DE97C19C-B238-4F7F-9D25-7DB30E8C24B2}&end&base-path=C:/Office%20Enterprise%202007%20Training%20Notebook
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OneNote Basics

How are OneNote pages different?

This is an example of a normal page of notes. Yotygenanywheret justclick and type For exampleype
your name hereThen try movingitaround.

What are all the tabs?

OneNote is a place for gathering, organizing, searching, and sharing notes, clippings, thoughts, referenci
materials, and other information. All your notes will be visible hererganized by notebooks, sections, and
pages. You can create them by clickilg > New

Notebooks:

Sections in the current notebook:

Start with one or two. Sections let you organize notes by activities, topics

people_ig_;j/ou-[ life. Start with a few in each notebog

Pagesinthe current section:
,Create as many note pages
leach section as you want.
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Meeting Notes | Business Trips 5 Project ideas \ Brainstorming \ ‘Work bog \ Search Al Notebaaks O =
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- Conference trip

E-mail trip itinerary to Anne
Get last slide updates from John

Airplane Tickets:

Confirmation numbear: N54321
Departure - Monday, 8:23am
Arrival - dpmi

Return - Thursday, 9:15am

Conference location:

_IMew Page ¥ |
Contuso visk )

Conference trip l

SpeciaUnfiled Notes section  for note pages you need to create in a hurry. You can drag them elsewhere
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M There is no Save button on the toolbar because OneNates all your notes automatically

How can OneNote help me?

Take a few minutes to learn more about OneNote anthiist important features
Flip through the page tabs in this section (on the righhd side):

Saarch Al haaeed

I} OneNote ... | Getting Started with GneSote ™ joee Cool Festures

1. OneMote Basics 1. et baskcs |
it Mo o Orashiote

e St
3 Take notes of ma |

How are OneNote pages different? 4. Gather screen e |

This is an example of & normal page of notes. You can type avywhene — |ust cick and type. For examgle, type
your name here. Than try moving i around 4. Search your noles
7. Work with Outlock: |

& Sered retes to cith |
e il
. Togimpertant fot )
10, U shired note )

‘ T

. Hewr Lz argadize n

£ oomiotaguide [ Pesonal [ work =

et its bl
2. Hore resouroes

What are all the tabs?

Upgrading from OneNote 2003? Make sure to check out page 11 after you have looked through the other
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The New User Interface

Microsoft Office Fluent user interface demo

Try out the Microsoft Office Fluent user interface with this interactive demo. In this demo y«
use the Ribbon, Contextual Tabs, Galleries, and Live Preview to quickly and easily get
LINEPFSaaArzylf NBadzZ Ga Ay aAONRaz2fid hTFAaOL
see sideby-side comparisons with previous versions of the applications that shows how mu
easieritis to getthings done with the Office Fluent user interface.

The 2007 Microsoft Office system
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http://r.office.microsoft.com/r/rlidFluentDemo

Old Ul vs. New Ul

In previous version of the Microsoft Office system, the interface was designed around menus, which
made new commands hard to find, and toolbars, which could resultin a cluttered workspace.
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Prepared by the Executive Leadershp Coung
Introduction

o market position end seck ncw markets for ow

Market Analysis
The worklwide market for musical instriments
15 0 Very malure, Very competitive market
Overall market growth for 2007 is estimated 1o
be ™5 aod 9% over 2000, m revenue and waxs
respectively Diswibution pattesns sury o et
deal by segment, from the sass retail
distribution of the low end 1o the speciaticed
distriburion of the bigh-quality asd high-price
sexmerts Fabrloam opersies in a narrow part o
ok the prarketinstruments and smmnment o Introduction

e T — The challenges we face aswe move into the planning cyce are significant, but with hard work and dear thinking
o 2 we are confident that we will be able to continue the strong growth path we've established over the last twel e
months.  Now is not the time 10 rest on our laurels — rather it is the time to consolidate our market position

#nd seak new markets for our products.

Fabrikam Q4 Executive Update

Prepared by the Executive Leadership Council under the direction of Justin Thorp CFO.

Market Analysis
The worlowide market for musical Instruments Is a very mature, very competitve market. Overall market
growth for 2007 is estimated to be 7% and 9% over 2006, in revenue and units respectively. Distrbution
patterms vary a great deal by segment, from the mass retall
distnbution of the iow end to the special zed distribution of the
high-guality and high-price segments. Fabrikam Operates in &
narrow part of arke sold to
professionals who nsist on the highest-guality soe=s

OUF CUSTOMETS 3re CONCRrT MUSS s =

— FR.0ffice

Fabrikam instrument Sales | :
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The redesigned interface for the 2007 release
uses space more efficiently to present comman
and options when you need them so you can ge



The Ribbon

Instead of menus and toolbars, the new interface uses a "ribbon" to organize commands. The 2007 Microsoft
system makes the tools you need easier to find through arich graphical display, which arranges commands a¢
to how you work with each application, how often the commands are typically used, and the results you wantt
achieve.

Word
The features that are used the most for

f . cia o Fabrkam Journal - Microsoft Werd - o x
| Home | Insem  pagelmowt Malings  Review  View -

i ——r—— o e x working on documents are located on
: [Combeia - - (RS (B "-"”i’?lm@ AaBbCcD| AABBC AaBbCe A ‘Mﬁ i'..,, the Home tab, so users naturally
Pute o [ B2 e x x A | (Wl O G | voma | readngt Hedng2 < e 1| e o seiea become more familiar with the new
Clipboard Font i Paragraph 5 Styte =\ Find

interface the more they use it.

PowerPoint Markating Strategy - Microsoft PowerFoint -Aa'x

The Design tab is where you'll find ShdeShow  Review  View -

all the features used to design and . - IRceton 'Q. 4 3 Quick Styles ~ | SiBring ta Front - |2 Agn *

lay out slides in Microsoft Office Aa » [@Fonts= | - | dySendto Back ~ I8 Grou

PowerPointe 2007 e = [Clemeas ~ | - OMBICIOUNI GIaphics | @y coyection pane 54 Rotate *
werPointe A . |

Excel

The Insert tab streamlines the steps
required to insert a chartinto a
spreadsheet in Microsoft Office
Excel® 2007.

Outlook

As you work with different commands in
Microsoft Office Outlooks 2007, you'll
see how the ribbon gives you access to
just the tools you need to complete the
task at hand.

Ca Office”
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Contextual Tabs

To prevent clutter and make commands easier to find when you need them, certain commands re
hidden until they are activated by how you are working with your document.

Forexample, when you
insertor click inside
Atable, the Table Tools tab
appears, and the ribbon
changesto display the
commands you need to
work with your table.
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wide. The new esecutive leadership team outined in the table below wil streamiine each of our regonal
operations to maximize profit i the wary that best sults the capabilisies of their region

.

We £an masimize cur salec targees in gon, a place where gage our famtiar
£round wAth ur new structure, This wil aliow our giobal enterprise to Optimize our nventory, sales
management and capital Investments to grow the business Thisis part of the angoing effart of the Fabrikam to
demonstrate leadership, Nlextilly and prowess in the widget industry
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The Office Button

The Office Button lets you access commands to work with your document at the file and system
from simply opening afile to saving to as a PDF to starting a workflow or publishing a documen
server.
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